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ABSTRAK 

 

Dalam perencanaan bangunan konstruksi bertingkat perlu memperhatikan segala aspek 

yang mempengaruhi struktur bangunan dan  pertimbangan yang matang, terutama bila 

suatu gedung bertingkat dirancang tahan terhadap gempa maka pertimbangan struktur 

akan mempengaruhi perencana dalam menentukan alternatif perencanaan. Perencanaan 

bangunan bertingkat perlu memperhatikan beberapa kriteria, antara lain kriteria 

kekuatan, perilaku struktur yang baik pada taraf gempa rencana serta aspek ekonomis.  

Topik bahasan dititikberatkan pada perbandingan dimensi tulangan balok rencana    

terhadap analisa struktur. Tujuan penulisan laporan ini adalah untuk mengetahui serta 

mengontrol bagaimana perhitungan penulangan lentur pada struktur balok. 

Untuk pemecahan masalah ini dilakukan studi kasus yang memberikan informasi 

teoritis dan analisis. Informasi yang berbentuk data diolah melalui simulasi komputer 

Program Analisa Struktur. Atas pemodelan yang dibuat, dianalisis untuk memperoleh 

hasil dan dibahas untuk perhitungan perbandingan dimensi tulangan balok. 

Hasil perhitungan yang diperoleh dari perbandingan dimensi tulangan struktur balok 

portal AS-32 didapat lebih sedikit jumlah tulangan hasil kontrol perhitungan dari jumlah 

tulangan  yang digunakan di lapangan dengan nilai perbandingan max 33%, adanya 

perbedaan itu terjadi karena asumsi-asumsi atau metode-metode yang berbeda di dalam 

analisa perhitungan.  

 
Kata Kunci: Balok, Penulangan, Portal, SAP2000 
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ABSTRACT 
 

 

In the planning of multi-storey construction buildings need to pay attention to all 

aspects that affect the structure of the building and consideration of mature, especially 

if a multi-story building is designed to withstand earthquakes, the structure 

considerations will affect the planner in determining alternative planning. Multi-storey 

building planning needs to pay attention to several criteria, including strength criteria, 

good structural behavior at the stage of the earthquake plan as well as economical 

aspects. 

Discussion topics focused on the comparison of reinforcement plan beam dimension to 

structural analysis. The purpose of this report is to know and control how the 

calculation of flexural repetition on the beam structure. 

For solving this problem a case study is provided that provides theoretical information 

and analysis. Information in the form of data is processed through computer simulation 

Program Structure Analysis. Above modeling is made, analyzed to obtain results and 

discussed for calculation of beam reinforcement dimension ratio. 

The result of calculation obtained from comparison of reinforcement dimension of 

portal structure of AS-32 port obtained less amount of reinforcement result of 

calculation from amount of reinforcement used in field with max comparison value 

33%, the difference happened because different assumptions or methods in the 

calculation analysis. 

 

Keywords: Beams, Portal, Repeatability, SAP2000 
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DAFTAR NOTASI 

 

  : Kuat nominal; diameter tulangan.  

  : Faktor reduksi. 

U  : Kuat perlu. 

ØMn  : Kuat nominal momen rencanaa.  

ØVn   : Kuat nominal gaya geser rencana. 

ØPn  : Kuat nominal gaya torsi rencana. 

fy  : Tegangan leleh rencana baja.  

f'c  : Kuat tekan beton. 

fs  : Tegangan tarik izin tulangan baja. 

As   : Luas penampang tulangan. 

ɛy  : Regangan luluh tulangan baja. 

I  : Faktor keutamaan gedung. 

µ  : Koefisien nilai faktor daktilitas. 

T  : Periode / waktu getar bangunan. 

V  : Gaya geser dasar horizontal. 

C1  : Koefisien gempa dasar. 

I  : Faktor keutamaan bangunan. 

W  : Berat total bangunan. 

R  : Faktor jenis struktur. 

D  : Diameter tulangan. 

ρmaks  : rasio tulangan maksimum. 

R  : Faktor jenis struktur. 
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BAB I 

PENDAHULUAN 

 

1.1 Latar Belakang 

Seiring dengan perkembangan penduduk semakin pesat di Indonesia 

sementara lahan yang tersedia semakin sempit terkhusus diperkotaan maka 

banyak orang lebih memilih rumah tempat tinggal mereka berbentuk Ruko, 

dimana selain dapat dijadikan tempat tinggal dapat juga dijadikan sebagai tempat 

usaha. Rumah toko atau yang sering disebut dengan Ruko adalah sebutan bagi 

bangunan-bangunan di Indonesia yang umumnya bertingkat antara dua hingga 

lima lantai, di mana lantai-lantai bawahnya digunakan sebagai tempat berusaha 

ataupun semacam kantor sementara lantai atas dimanfaatkan sebagai tempat 

tinggal. Hal ini benar-benar menjadi lahan bisnis dalam dunia konstruksi yang 

berkembang saat ini. Karena bentuk bangunan yang dianggap sederhana sering 

kali terjadi pengawasan yang kurang efisien dalam pembangunan Ruko sehingga 

sering terjadi kerusakan Ruko sebelum Ruko selesai dibangun. Mengingat 

pentingnya hal tersebut maka penulis memilih topik pembahasan tentang kontrol 

dimensi tulangan balok rencana terhadap analisa struktur pada Proyek 

Pembangunan Ruko Citraland Bagya City Medan. Dalam hal ini penulis khusus 

membahas balok  pada proyek tersebut. Dimana balok merupakan salah satu 

struktur utama yang berfungsi untuk meneruskan beban konstruksi ke kolom. 

Adapun yang dimaksud dengan balok adalah bagian dari struktur yang berfungsi 

untuk menopang lantai diatasnya, balok juga berfungsi menyalurkan pembebanan 

ke kolom. Balok dikenal sebagai elemen lentur yaitu elemen struktur yang 

dominan memikul gaya dalam berupa momen lentur dan juga geser. Disini penulis 

akan memaparkan apakah dimensi tulangan balok yang direncakan sudah aman 

dan ekonomis terhadap penampang. 
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1.2 Maksud dan Tujuan Penelitian 

 Maksud penelitian ini adalah menghitung dimensi tulangan balok terhadap 

analisa struktur pada R6 portal AS-32 berdasarkan SNI 2847 : 13.  

Tujuan penelitian ini adalah membandingkan dimensi tulangan balok yang 

sudah terlaksana di proyek dengan perhitungan tulangan balok berdasarkan SNI 

2847 : 13. 

 

1.3 Perumusan Masalah 

Adapun permasalahan yang akan timbul dalam pembahasan ini adalah 

Bagaimana membandingkan tulangan balok yang ada di proyek dengan 

perhitungan menurut SNI 2847 : 13 dengan memakai metode SAP 2000 V.12.  

 

1.4 Kerangka Penulisan 

Adapun kerangka penulisan ini adalah: 

BAB I  Pendahuluan; Latar belakang, Maksud dan Tujuan Penelitian, 

perumusan masalah, Kerangka Penulisan. 

BAB II  Tinjauan Pustaka; Beton Bertulang, Portal, Pembebanan Pada 

Struktur Bangunan Bertingkat, Kombinasi Momen Rencana Balok, Analisis 

dan Desain Struktur Menggunakan SAP 2000 v.12 

BAB III Metodelogi Penelitian; Tahapan Penelitian, Teknik Pengolahan 

Data. 

BAB IV Pembahasan; Kontrol Dimensi Balok Rencana Terhadap Analisa 

Struktur. 

BAB V Kesimpulan dan Saran. 
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BAB II 

TINJAUAN KEPUSTAKAAN 

 

2.1 Struktur Beton dan Beton Bertulang 

Proses desain suatu struktur secara garis besar dilakukan melalui dua tahapan 

yaitu: 

a. Menentukan gaya-gaya dalam yang bekerja pada struktur tersebut dengan 

menggunakan metode-metode analisis struktur yang tepat. 

b. Menentukan dimensi dan ukuran dari tiap elemen struktur secara 

ekonomis dengan mempertimbangkan faktor keamanan, stabilitas, 

kemampulayanan, serta fungsi dari struktur tersebut. 

Beton adalah salah satu jenis material yang paling sering digunakan dalam 

pembuatan berbagai jenis struktur. Beton sendiri adalah material konstruksi yang 

diperoleh dari pecampuran pasir, kerikil / batu pecah, semen serta air. Terkadang 

beberapa macam bahan tambahan dicampurkan kedalam campuran tersebut 

dengan tujuan memperbaiki sifat-sifat dari beton, yakni antara lain untuk 

meningkatkan workability, durability, serta waktu pengerasan beton. 

Campuran beton tersebut seiring dengan bertambahnya waktu akan menjadi 

keras seperti batuan, dan memiliki kuat tekan yang tinggi namun kuat tarik yang 

rendah. Beton bertulang adalah kombinasi dari beton serta tulangan baja, yang 

bekerja secara bersama-sama untuk memikul beban yang ada. Tulangan baja akan 

memberikan kuat tarik yang tidak dimiliki oleh beton. Selain itu, tulangan baja 

juga mampu memikul beban tekan, seperti digunakan pada elemen kolom beton. 

Agar suatu bangunan struktur beton bertulang dapat berfungsi dengan baik maka 
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seorang perencana wajib mendesain elemen-elemen strukturnya dengan benar dan 

tepat. Pada suatu struktur beton bertulang dikenal beberapa jenis elemen yang 

sering digunakan yaitu elemen pelat lantai, balok, kolom, dinding dan pondasi. 

1. Pelat Lantai 

Pelat lantai adalah suatu elemn horizontal utama yang berfungsi untuk 

menyalurkan beban hidup, baik yang bergerak maupun statis ke elemen 

pemikul beban vertikal, yaitu balok, kolom dan dinding. 

2. Balok 

Balok adalah elemen horizontal ataupun miring yang panjang dengan 

ukuran lebar serta tinggi yang terbatas. Balok berfungsi untuk 

menyalurka beban dari pelat. Pada umumnya balok dicetak secara 

momolit dengan pelat lantai, sehingga akan membentuk balok 

penampang T pada balok interior dan balok penampang. 

3. Kolom  

Kolom merupakan elemen penting yang memikul beban dari balok 

dan pelat. Kolom dapat memikul beban aksial saja, namun lebih 

sering kolom direncanakan sebagai pemikul beban kombinasi aksial 

dan lentur. 

4. Rangka  

Rangka adalah gabungan antara elemen balok dan rangka akan 

membentuk suatu sistem struktur rangka. Sistem struktur rangka dapat 

merupakan statis tertentu dan tak tentu. 
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5. Dinding 

Dinding merupakan elemen pelat vertikal yang dapat memikul beban 

gravitasi maupun beban lateral seperti dinding pada lantai basement 

atau dapat direncanakan memikul beban lateral gempa bumi dikenal 

dengan dinding geser (Shear wall). 

6. Pondasi 

Pondasi adalah elemen pemikul beban dari kolom yang kemudian 

menyalurkannya kelapisan tanah keras. 

 

2.2 Standar Perencanaan 

 Proses perencanaan dan konstruksi struktur bangunan di Amerika sebelum 

tahun 2000 dikenal 3 macam standar perencanaan bangunan yaitu Uniform 

Building Code (UBC), Standard Building Code, dan Basic Building Code. Setelah 

tahun 2000 ketiga macam peraturan diperbaharui oleh International Building 

Code (IBC) per tiap 3 tahun sekalinya. Peraturan desain yang spesifik untuk 

struktur beton bertulang diatur dalam Building Code Requirements for Structural 

Concrete (ACI 318-11), sedangkan di Indonesia menggunakan SNI 2847:2013 

Persyaratan Beton Struktural untuk Bangunan Gedung yang disusun dengan acuan 

ACI. Konsep yang dianut SNI dikenal sebagai metode LFRD (Load and 

Resistance Factor Design). Adapun persyaratan dasar yang harus dipenuhi dalam 

desain adalah: 

Kuat Rencana ≥ Kuat Perlu 

Ø (Kuat Nominal) ≥ U 

 

.................................... Pers 2.1 
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Kuat nominal menggambarkan tingkat kekuatan elemen struktur yang dapat 

dihitung dengan metode-metode konservatif yang telah di standarkan dalam 

peraturan, sedangkan kuat perlu (U) dihitung dengan mempertimbangkan faktor 

beban sesuai jenis beban yang bersangkutan seperti beban mati (D), beban hidup 

(L), beban angin (W), atau beban gempa (E). Secara khusus untuk elemn struktur 

yang memikul momen lentur, geser dan gaya aksial, maka persamaannya sebagai 

berikut: 

ØMn ≥ Mu 

 

ØVn ≥ Vu 

 

ØPn ≥ Pu 

 

Indeks n menunjukkan kuat momen lentur, kuat geser dan gaya aksial 

nominal sedangkan indeks u menunjukkan beban terfaktor dari momen lentur, 

gaya geser dan gaya aksial yang harus dipikul elemen struktur tersebut. Untuk 

menghitung beban terfaktor pada sisi kanan persamaan tersebut, maka besarnya 

masing-masing beban dikalikan dengan faktor beban yang bersesuaian dan 

dikombinasikan sesuai standar peraturan yang berlaku. 

 

 

 

 

 

.................................... Pers 2.2 

.................................... Pers 2.3 

.................................... Pers 2.4 
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2.3 Perilaku Balok Beton Bertulang 

 Balok tidak efesien sebagai fungsi komponen struktur lentur, karena kuat 

tariknya jauh lebih kecil dibandingkan kuat tekannya. Untuk alasan inilah maka 

tulangan baja diletakkan pada bagian penampang yang mengalami tegangan tarik, 

sedekat mungkin dengan serat tarik terluar dari balok beton. Pada balok beton 

bertulang, gaya tarik yang timbul sebagai akibat dari momen lentur ditahan oleh 

tulangan baja, sedangkan beton sendiri bekerja menahan gaya tekan yang timbul. 

Untuk mencegah terjadinya slip antara tulangan baja dan beton serta menjamin 

terjadinya lekatan yang baik disarankan menggunakan tulangan baja ulir. 

 Berdasarkan presentase tulangan baja yang digunaka dalam suatu komponen 

struktur balok, maka terdapat 3 macam keruntuhan lentur balok yang dapat 

terjadi: 

a. Tulangan baja akan mencapai kuat luluhnya sebelum beton mencapai kuat 

maksimumnya. Pada kasus ini, keruntuhan disebabkan oleh luluhnya 

tulangan baja akibat regangan yang cukup tinggi mencapai 0,005 atau 

lebih. 

b. Tulangan baja akan mencapai kuat luluhnya dan pada saat yang bersamaan 

beton mencapai regangan ultimitnya sebesar 0,003. 

c. Pada balok dengan presentase tulangan baja yang cukup besar, beton akan 

runtuh sebelum tulangan baja mencapai kuat luluhnya. Disini beton 

mencapai kuat tekan dan regangan ultimitnya, namun tegangan pada 

tulangan baja (fs), masih jauh dibawah tegangan luluhnya, sedangkan 

regangan pada tulangan baja akan sama dengan atau kurang dari 0,002. 
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Gambar 2.1 Tiga macam keruntuhan balok ditinjau dari presentase  tulangan baja. 

 

Di dalam perencanaan beton bertulang biasa maupun beton prategang dalam  

SNI 2847:2013, berdasarkan konsep regangan yang terjadi pada penampang beton 

dan tulangan baja, ada 3 macam jenis penampang yang didefenisikan sebagai 

berikut: 

1. Kondisi regangan seimbang (balanced strain condition). Kondisi ini 

terjadi pada satu penampang ketika tulangan baja tarik mencapai regangan 

luluh (ɛy), sedangkan beton yang tertekan mencapai regangan ultimitnya 

sebesar 0,003. Penampang demikian dinamakan sebagai penampang 

seimbang. 

2. Penampang terkendali tekan (compression controlled section). Ini terjadi 

apabila regangan tulangan tarik keluar sama atau kurang dari batasan 

regangan yang diizinkan, sedangkan beton mencapai regangan ultimit sebesar 

0,003. Untuk tulangan baja dengan fy = 400 MPa, batasan regangan tekan 

sama dengan 0,002. Kasus ini umumnya terjadi pada komponen struktur 

kolom yang menerima gaya aksial dan momen lentur. 

As 

d 

 cb 

ɛs ≥ 0,005 ɛs = ɛy = fy / Es ɛs  ɛy = 0,002 

ɛs  ɛcu ɛcu = 0,003 ɛcu = 0,003 

(a) (b) (c) 
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3. Penampang terkendali tarik (tension controlled section). Ini terjadi ketika 

regangan baja mencapai 0,005 atau lebih, yang terjadi ketika beton mencapai 

regangan ultimitnya sebesar 0,003.  

Kuat nominal dari suatu komponen struktur (baik yang memikul lentur, beban 

aksial, geser maupun puntir), yang dihitung berdasarkan kaidah-kaidah yang 

berlaku, harus dikalikan dengan faktor reduksi yang besarnya kurang dari satu. 

Hasil kali antara kuat nominal dengan faktor reduksi disebut kuat rencana. 

Penggunaan faktor reduksi dilakukan dengan mengingat beberapa hal sebagai 

berikut: 

a. Untuk mengantisipasi segala ketidakpastian dari kuat nominal 

penampang akibat dimensi material, serta ketidakakuratan persamaan-

persamaan dalam perencanaan. 

b. Untuk merefleksikan tingkat daktilitas dan keandalan komponen struktur 

akibat efek yang ditimbulkan oleh beban kerja. 

c. Untuk merefleksikan tingkat kepentingan suatu komponen struktur. 

 

 
           Gambar 2.2 Kurva Hubungan Tegangan dan Regangan 

           (Sumber : Struktur Beton Bertulang, Istimawan Dipohusodo) 
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Dalam SNI 2847:2013 pasal 9.3 digunakan beberapa nilai faktor reduksi 

kekuatan (), sebagai berikut: 

 Untuk penampang terkendali tarik  = 0,90 

 Untuk penampang terkendali tekan  

 Dengan tulangan spiral   = 0,75 

 Tulangan non-spiral    = 0,65 

 Untuk geser dan puntir    = 0,75 

 Untuk tumpu pada beton    = 0,65 

 

2.4 Beban  

 Beban adalah gaya luar yang bekerja pada suatu struktur. Penentuan secara 

pasti besarnya beban yang bekerja pada suatu struktur selama umur layanyan 

merupakan salah satu pekerjaan yang cukup sulit. Pada umumnya penentuan 

besarnya beban hanya merupakan suatu estimasi saja. Distribusi beban dari 

elemen ke elemen dalam suatu struktur memerlukan asumsi dan pendekatan. 

Beberapa jenis beban yang sering dijumpai antara lain: 

1. Beban Mati 

Beban mati adalah beban gravitasi yang berasal dari berat semua 

komponen gedung/bangunan yang bersifat permanen selama masa layan 

struktur tersebut. Termasuk pula kedalam jenis beban mati adalah unsur-

unsur tambahan, mesin serta peralatan tetap yang tak terpisahkan dari 

gedung tersebut. Selain itu berat sendiri struktur, sistem perpipaan, 

jaringan listrik, penutup lantai, serta plafon juga msaih termasuk beban 

UNIVERSITAS MEDAN AREA



11 
 

mati. Besar beban mati pada suatu gedung dapat dilihat pad tabel dibawah 

ini: 

     Tabel 2.1 Berat sendiri bahan bangunan 

NO Bahan Bangunan 

Berat 

Sendiri 

(Kg/m
3
) 

1 Baja 7850 

2 Batu Alam 2600 

3 Batu belah, batu bulat, atau gunung (berat tumpuk) 1500 

4 Batu Krang (berata tumpuk) 700 

5 Batu Pecah 1450 

6 Besi tuang 7250 

7 Beton 2200 

8 Beton Bertulang 2400 

9 Kayu (kelas I) 1000 

10 Kerikil, koral (kering udara sampai lembab tanpa ayak) 1650 

11 Pasangan bata merah 1700 

12 pasangan batu belah, batu bulat,batu gunung 2200 

13 Pasangan batu cetak 2200 

14 pasangan batu karang 1450 

15 Pasir (kering udara sampai lembab) 1600 

16 Pasir (jenuh air) 1800 

17 Pasir kerikil, koral (kering udara sampai lembab) 1850 

18 Tanah lempung dan lanau (kering udara sampai lembab) 1700 

19 Tanah lempung dan lanau (basah) 2000 

20 Timah hitam (timbel) 11400 

       (Sumber : Peraturan Pembebanan Indonesia untuk Gedung 1983) 
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        Tabel 2.2  Berat sendiri komponen gedung 

Komponen Gedung  kg/m² 

Adukan, per cm tebal:   

 - dari semen 21 kg/m2 21 

 - dari kapur, semen merah atau tras 17 

Aspal, termasuk bahan-bahan mineral tambahan, per cm tebal 14 

Dinding Pas. Bata merah:   

 - satu batu 450 

 - setengah batu 250 

Dinding pasangan batako:   

Berlubang:   

 - tebal dinding 20 cm (HB 20) 200 

 - tebal dinding 10 cm (HB 10) 120 

Tanpa lubang   

 - tebal dinding 15 cm 300 

 - tebal dinding 10 cm  200 

Langit-langit dan dinding (termasuk rusuk-rusuknya, tanpa   

penggantung langit-langit atau pengaku), terdiri dari:   

 - semen asbes (eternit dan bahan lain sejenis), dengan tebal   

    maksimum 4 mm 11 

 - kaca, dengan tebal 3 – 4 mm  10 

Lantai kayu sederhana dengan balok kayu, tanpa langit   

langit dengan bentang maksimum 5 m dan untuk beban hidup 

maksimum 

200 

Penggantung langit-langit (dari kayu), dengan bentang maksimum 7 

5 m dan jarak s.k.s minimum 0,8 m   

Penutup atap genting dengan reng dan usuk/kaso per m
2
 bidang atap 50 

Penutup atap sirap dengan reng dan usuk/kaso per m
2 

bidang atap 40 

Penutup atap seng gelombang (BWG 24) tanpa gordeng 10 

Penutup lantai dari ubin semen portland, teraso dan beton 24 

tanpa adukan, per cm tebal   

Semen asbes gelombang (tebal 5 mm) 11 
 (Sumber : Peraturan Pembebanan Indonesia untuk Gedung 1983) 
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2. Beban Hidup 

Beban Hidup termasuk kedalam kategori beban gravitasi yaitu jenis beban 

yang timbul akibat penggunaan suatu gedung selama masa layan gedung 

tersebut. Beban manusia, peralatan yang dapat dipindahkan, kendaraan 

bermotor, serta barang/benda lain yang letaknya tidak permanen. 
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Tabel 2.3 Beban hidup 

Beban Hidup Kg/m
2
 

a.    Lantai dan tangga, kecuali yang di sebut dalam (b) 200 

b.   Lantai dan rumah tinggal sederhana dan gudang-gudang 

tidak penting, yang bukan untuk toko atau ruang kerja 

 125 

c.    Lantai sekolah, ruang kuliah, kantor, toko, restorant, hotel,    

       asrama dan rumah sakit. 250 

d.   Lantai ruang olahraga 400 

e.   Lantai ruang dansa 500  

f.    Lantai dan balkon dalam dari ruang-ruang untuk pertemuan    

      yang lain dari pada yang di sebut  dalam (a) s/d (e), seperti    

      mesjid, gereja, ruang pagelaran, ruang rapat, bioskop, dan  400 

      panggung penonton dengan tempat duduk tetap.   

g.   Panggung penonton tempat duduk tidak tetap atau untuk  500 

      penonton yang berdiri   

h.   Tangga, bordes tangga, lantai, dan gang dari ruang-ruang 

yang  

300 

       disebut dalam poin (c)   

i.      Tangga, bordes tangga, lantai, dan gang dari ruang-ruang 500 

        yang disebut dalam poin (d), (e), (f) dan (g)   

j.      Lantai ruang pelengkap dari ruang-ruang yang di sebut (c),  250 

        (d), (e), (f), dan (g)   

k.    Lantai untuk: pabrik, bengkel, gudang, perpustakaan, ruang    

       arsip, toko buku, toko besi, ruang alat-alat danruang mesin,    

       harus direncanakan terhadap beban hidup yang ditentukan  400 

       tersendiri, dengan minimum   

l.      Lantai gedung parkir bertingkat:   

        -          Untuk lantai bawah 800 

        -          Untuk lantai tingkat lainnya 400 

m.  Balkon-balkon yang menjorok bebas keluar harus    

      direncanakan terhadap beban hidup dari lantai ruang yang 300 

       berbatasan, dengan minimum 

o.   beban hidup pada atap atau bagian atap serta pada struktur 

tudung    (kanopy) yang dapat dicapai dan dibebani oleh 

orang, harus diambil    minimum sebesar 100 kg/m
2
 bidang 

datar. 

100 

         (Sumber : Peraturan Pembebanan Indonesia untuk Gedung 1983) 
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3. Beban Angin 

Beban angin adalah beban yang timbul sebagai akibat adanya tekanan dari 

gerakan angin. Beban angin sangat ditentukan oleh lokasi dan ketinggian 

dari struktur bangunan. Intensitas tekanan tiup yang direncanakan dapat 

diambil minimum sebesar 25 kg/m
2
, kecuali untuk kondisi berikut: 

a. Tekanan tiup di tepi laut sampai sejauh 5 km dari pantai harus diambil 

minimum 40 kg/m
2
. 

b. Untuk bangunan di daerah lain yang kemungkinan tekanan tiupnya 

lebih dari 40 kg/m
2
 

c. Untuk cerobong, tekanan tiup dalam kg/m
2
 harus ditentukan dengan 

rumus (42,5 + 0,6h), dengan h adalah tinggi cerobong seluruhnya dalam 

meter. 

 

4. Beban Gempa 

a. Ketentuan gempa rencana 

Adapun gempa rencana yang digunakan dalam analisis perhitungan gempa 

dimaksudkan untuk menentukan pengaruh Gempa Rencana yang harus 

ditinjau dalam perencanaan struktur gedung serta berbagai bagian dan 

peralatannya secara umum. Akibat pengaruh Gempa Rencana, struktur 

gedung secara keseluruhan harus masih berdiri, walaupun sudah berada 

dalam kondisi di ambang keruntuhan. Gempa Rencana ditetapkan 

mempunyai perioda ulang 500 tahun, agar probabilitas terjadinya terbatas 

pada 10% selama umur gedung 50 tahun. Untuk berbagai kategori gedung, 

bergantung pada probabilitas terjadinya keruntuhan struktur gedung 
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selama umur gedung dan umur gedung tersebut yang diharapkan, pengaruh 

Gempa Rencana terhadapnya harus dikalikan dengan suatu Faktor 

Keutamaan I menurut persamaan:  

 

I = I1 . I2  

di mana I1 adalah Faktor Keutamaan untuk menyesuaikan perioda ulang 

gempa berkaitan dengan penyesuaian probabilitas terjadinya gempa itu 

selama umur gedung, sedangkan I2 adalah Faktor Keutamaan untuk 

menyesuaikan perioda ulang gempa berkaitan dengan penyesuaian umur 

gedung tersebut. Faktor-faktor Keutamaan I1, I2 dan I ditetapkan menurut 

tabel dibawah ini. 

Tabel 2.4 Faktor keutamaan I untuk berbagai kategori gedung 

Kategori gedung Faktor Keutamaan 

   
 

I1 I2 I 
 

 
 

Gedung  umum  seperti  untuk  penghunian, 1,0 1,0 1,0 
 

perniagaan dan perkantoran    
 

    
 

Monumen dan bangunan monumental 1,0 1,6 1,6 
 

    
 

Gedung penting pasca gempa seperti rumah 1,4 1,0 1,4 
 

sakit, instalasi air bersih, pembangkit tenaga    
 

listrik, pusat penyelamatan dalam keadaan    
 

darurat, fasilitas radio dan televisi.    
 

    
 

Gedung untuk menyimpan bahan berbahaya 1,6 1,0 1,6 
 

seperti  gas,  produk  minyak  bumi,  asam,    
 

bahan beracun.    
 

    
 

Cerobong, tangki di atas menara 1,5 1,0 1,5 
 

    

        (Sumber: SNI 03-1726-2002) 

 

Catatan: 

Untuk semua struktur bangunan gedung yang ijin penggunaannya 

diterbitkan sebelum berlakunya Standar ini maka Faktor Keutamaan I 

dapat dikalikan 80%. 

 

.................................... Pers 2.5 
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a. Daktilitas struktur bangunan dan pembebanan gempa nominal 

Faktor daktilitas struktur gedung µ adalah rasio antara simpangan 

maksimum struktur gedung akibat pengaruh Gempa Rencana pada saat 

mencapai kondisi di ambang keruntuhan δm dan simpangan struktur 

gedung pada saat terjadinya pelelehan pertama δy, yaitu: 

 

 ,0       
δm

δy
    

m
 

 

Dimana µ = 1,0 adalah nilai faktor daktilitas untuk struktur gedung yang 

berperilaku elastik penuh, sedangkan µm adalah nilai faktor daktilitas 

maksimum yang dapat dikerahkan oleh sistem struktur gedung yang 

bersangkutan. Nilai faktor daktilitas struktur gedung µ di dalam 

perencanaan struktur gedung dapat dipilih menurut kebutuhan, tetapi 

tidak boleh diambil lebih besar dari nilai faktor daktilitas maksimum µm 

yang dapat dikerahkan oleh masing-masing sistem atau subsistem 

struktur gedung. Dalam tabel faktor daktilitas maksimum, faktor reduksi 

gempa maksimum, faktor tahanan lebih struktur dan faktor tahanan lebih 

total beberapa jenis sistem dan subsistem struktur gedung ditetapkan nilai 

µm yang dapat dikerahkan oleh beberapa jenis sistem dan subsistem 

struktur gedung, berikut faktor reduksi maksimum Rm yang 

bersangkutan. 

 

 

 

.................................... Pers 2.6 
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Tabel 2.5 Parameter daktilitas struktur gedung 

Taraf Kinerja Struktur Gedung µ R 

Elastik Penuh 1,0 1,6 

Daktail Parsial 1,5 2,4 

2,0 3,2 

2,5 4,0 

3,0 4,8 

3,5 5,6 

4,0 6,4 

4,5 7,2 

5,0 8,0 

Daktail Penuh 5,3 8,5 

 

 

b. Perencanaan struktur gedung 

Beban gempa adalah semua beban statistic ekuivalen yang bekerja 

pada gedung atau bagian gedung yang menirukan pengaruh dari gerakan 

tanah akibat gempa itu. Dalam hal pengaruh gempa pada struktur gedung 

di tentukan berdasarkan suatu analisa dinamik, maka yang di artikan 

dengan beban gempa di sini adalah gaya-gaya dalam struktur tersebut 

yang terjadi oleh gerakan tanah akibat gempa itu. 

Perecanaan struktur tahan gempa dilakukan dengan memodelkan 

struktur dengan meninjau beban gempa sebagai salah satu kombinasi 

bebannya. Metode yang digunakan untuk perhitungan  beban gempa 

diantaranya adalah analisis dinamik respon spektrum. Dalam respon 

spektra, efek dari ukuran dan tipe gelombang getar yang terjadi saat 

gempa disimplifikasi dari garis-garis yang bergelombang menjadi suatu 

garis tertentu. Spektra yang digunakan dalam perencanaan adalah respon 

percepatan dengan periode (T) . Respon spektra adalah plot dari respons 

maksimum struktur yang diperoleh dari riwayat waktu suatu gempa. 
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Respon maksimum yang dimaksud adalah nilai-nilai percepatan, 

kecepatan dan perpindahan maksimum. Nilai-nilai tersebut dicari untuk 

berbagai macam periode alami struktur, sehingga diperoleh spektra 

merepresentasikan respon maksimum terhadap periode struktur, sehingga 

dapat diperoleh respon spektra untuk percepatan, kecepatan dan 

perpindahan. 

Ketiga respon spektra tersebut (percepatan, kecepatan dan 

perpindahan) dapat secara simultan diplot ke dalam sebuah grafik skala 

log dengan 3 sumbu yang disebut tripartite (dikembangkan oleh 

Newmark). Dimana sumbu horizontal dapat berupa periode frekuensi, 

sumbu vertikal berupa respon kecepatan dan dua buah sumbu diagonal 

yang merupakan respon percepatandan perpindahan. Besarnya gempa 

rencana menurut pedoman perencanaan ketahanan gempa untuk rumah 

dan gedung SNI-03-1726 2002, dinyatakan: 

   
    

 
  t  

Dimana :  V = Gaya geser dasar horizontal 

   C1  = Koefisien gempa dasar 

     I   = Faktor keutamaan bangunan 

     W = Berat total bangunan 

     R  = Faktor jenis struktur 

 

 

.................................... Pers 2.7 
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Langkah-langkah perhitungan untuk mendapatkan gaya geser dasar 

horizontal akibat gempa adalah sebagai berikut: 

1. Menghitung berat total (Wt) 

 Berat bangunan ditotal secara menyeluruh (berat total bangunan) 

yang merupakan jumlah beban mati dan beban hidup total setiap 

lantai. Dimana beban-beban tersebut meliputi: berat plat, plafond, 

dinding, balok induk, balok anak dan kolom. Demikian juga pada 

perhitungan beban hidup. 

 

2. Menghitung waktu getar bangunan (T) 

Waktu getar struktur (T) adalah waktu yang diperlukan oleh 

struktur untuk melakukan satu getaran. Nilai waktu getar struktur 

tergantung pada kekakuan dan massa struktur. Dalam perhitungan 

awal struktur, waktu getar struktur dapat ditentukan dengan 

persamaan empiris berikut: 

(1) untuk portal beton, T = 0.06 H
3/4 

(detik)  

(2) untuk portal baja, T = 0.085 H
3/4 

(detik) 

(3) untuk jenis portal yang lain,         

  

 

   
0,0   

  
 

dimana: 

H : tinggi struktur bangunan diukur dari taraf penjepitan lateral 

(meter) 

.................................... Pers 2.8 
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B : lebar denah bangunan diukur tegak lurus gaya gempa (meter) 

Untuk perhitungan yang lebih detail, nilai T harus dihitung kembali  

dengan persamaan: 

 

     ,  √
   i   di 

g    i   di
  

  

Dimana: 

Wi : berat lantai i 

di   : perpindahan (displacement) lantai i 

g    : percepatan gravitasi (g = 9.81 m/dtk2) 

Fi   : beban geser (akibat gempa) pada lantai i 

 

Nilai T merupakan koreksi terhadap nilai T yang ditentukan 

sebelumnya. Apabila nilai T lebih kecil dari 80% nilai T hasil 

perhitungan sebelumnya, maka beban gempa harus dihitung kembali 

dengan menggunakan nilai T koreksi tersebut. Percepatan maksimum 

struktur juga dipengaruhi oleh kondisi tanah yang mempengaruhi 

perambatan gelombang gempa dari hypocenter ke permukaan tanah, dan 

pada akhirnya mempengaruhi intensitas gempa. Untuk mendapatkan 

ragam getar seperti ragam getar kesatu, beban geser dasar V 

didistribusikan sebagai beban geser tingkat F yang bekerja pada pusat 

massa masing-masing lantai. Beban geser tingkat dihitung dengan 

persamaan:  

.................................... Pers 2.9 
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 i  
 i     i

    i    i 
  

 

dimana: 

Fi   : beban geser lantai ke-i 

Wi  : berat lantai ke-i 

zi    : tinggi lantai ke-i, dihitung dari taraf penjepitan lateral 

V   : gaya geser dasar (base shear) 

 

2.5 Kombinasi Momen Rencana Balok 

Rencana penulangan suatu balok pada tumpuan diperhitungkan dengan   

menggunakan 7 (tujuh) kombinasi momen rencana yaitu sebagai berikut: 

Kombinasi 1 : Mu = 1,4 D 

Kombinasi 2 : Mu = 1,2D + 1,6L 

Kombinasi 3 : Mu = 1,2D + 1,0L  

Kombinasi 4 : Mu = 1,2D + 1,0W + 1,0L 

Kombinasi 5 : Mu = 1,2D + 1,0E + 1,0L 

Kombinasi 6 : Mu = 0,9D + 1,0W  

Kombinasi 7 : Mu = 0,9D + 1,0E 

 

2.6 Desain Lentur Balok Beton Bertulang 

 Menentukan dimensi Penampang serta luas tulangan baja yang dibutuhkan 

merupakan proses desain dimana agar struktur tersebut kuat dan ekonomis. Beton 

akan memikul tegangan tarik yang ditimbulkan oleh momen lentur, gaya aksial 

maupun efek susut pada beton. Suatu balok tertumpu sederhana memikul beban 

merata yang menimbulkan lentur pada balok. 

.................................... Pers 2.10 
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         Gambar 2.3 Balok Terlentur akibat beban sederhana 

 

Tahap dan metode perencanaan balok sangat bervariasi, dapat dikaji 

berdasarkan letak garis netral penampang balok (balok bertulangan seimbang, 

bertulangan lebih, dan bertulangan kurang), dan juga berdasarkan pembebanan 

dan tulangannya (balok bertulangan tarik saja dan balok bertulangan rangkap). 

Balok adalah elemen struktur yang menyalurkan beban-beban dari pelat ke 

kolom penyangga yang vertikal. Dalam kontruksi gedung biasanya balok dibagi 

menjadi tiga penampang yaitu balok L, T dan persegi. 

a. Balok Persegi bertulangan tunggal 

Suatu balok dinyatakan  bertulangan  tunggal jika pada penampang  

beton bertulang tersebut hanya diperhitungkan terpasang baja tulangan pada satu 

sisi saja, yaitu pada bagian serat yang menerima gaya tarik seperti yang 

ditunjukan pada Gambar 2.4. 
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               Gambar 2.4 Gambar penampang balok persegi bertulangan tunggal 

 

        Tabel 2.6 Nilai ρb, ρmaks dan Ru maks berbagai mutu beton dan mutu tulangan baja 

f'c (MPa) 1 fy (MPa) ρb ρmax Ru maks 

20 0,85 240 0,04301 0,02258 4,09962 

    400 0,02168 0,01355 4,09962 

25 0,85 240 0,05376 0,02822 5,12453 

    400 0,02709 0,01693 5,12453 

30 0,84 240 0,06342 0,03330 6,06535 

    400 0,03197 0,01998 6,06535 

35 0,8 240 0,07083 0,03719 6,82763 

    400 0,03570 0,02231 6,82763 

40 0,76 240 0,07734 0,0406 7,51338 

    400 0,03898 0,02436 7,51338 

 

Apabila nilai b, h, f'c dan fy sudah ada, maka sebaiknya harus diperiksa 

terlebih dahulu apakah tulangan tekan diperlukan atau tidak. Hal ini dapat 

diperiksa dengan urutan sebagai berikut: 

1. Asumsikan tulangan yang digunakan (cth: D25), lalu hitung nilai d= h - selimut 

beton – diameter sengkang - 1/2 

 itung nilai ρb dengan rumus sebagai berikut: 

 

 

UNIVERSITAS MEDAN AREA



25 
 

             

   

  
(

   

      
) 

 

2.  itung nilai ρmaks dengan rumus sebagai berikut:         

 

         (
       

  
  

     
) 

Atau ρmaks dapat dilihat pada tabel 2.6. 

3. Lalu hitung nilai Ru maks dengan rumus  sebagai berikut:      

                [   (
         

       
)]    

4. Hitung nilai Mn maks = Rubd
2
 (kuat momen rencana balok 

persegi tulangan tunggal). 

5. Jika Mu  Mn maks, maka tidak diperlukan tulangan tekan dan nilai ρ serta As 

dapat dihitung; As   ρ   b   d     

6. Jika Mu > Mn maks, maka diperlukan tulangan tekan dan dijelaskan pada balok 

persegi bertulangan rangkap. 

7. Untuk mengecek lebar balok minimum yang diperlukan rumusnya sebagai 

berikut: 

bmin = 5db + 100; db = diameter tulangan baja yang digunakan. 

 

b. Balok Persegi bertulangan rangkap 

Dalam analisis balok bertulangan rangkap, akan dijumpai dua jenis 

kondisi yang umum. Yang pertama yaitu bahwa tulangan tekan telah luluh 

bersamaan dengan luluhnya tulangan tarik saat beton mencapai regangan 

.................................... Pers 2.11 

.................................... Pers 2.12 

.................................... Pers 2.13 

.................................... Pers 2.14 
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maksimum 0,003. Sedangkan kondisi yang kedua yaitu dimana tulangan tekan 

masih belum luluh saat tulangan tarik telah luluh bersama dengan tercapainya 

regangan 0,003 oleh beton. 

Jika regangan tekan baja tekan (ε’s) sama atau lebih besar dari regangan luluhnya 

(εy), maka sebagai batas maksimum tegangan tekan baja tekan diambil sama 

dengan tegangan luluhnya (fy). Sedangkan apabila regangan tekan baja yang 

terjadi kurang dari regangan luluhnya, maka tegangan tekan baja adalah f’s = ε’s . 

Es. Dimana Es adalah modulus elastisitas baja. Tercapainya masing-masing 

keadaan (kondisi) tersebut tergantung dari posisi garis netral penampang. 

 

                            Gambar 2.5 Penampang balok persegi bertulangan rangkap 

Keterangan: 

h      = tinggi balok,  

b      = lebar balok, 

d      = tinggi balok dari tepi serat yang tertekan ke pusat tulangan tarik, 

As    = luas tulangan tarik dan 

As'   = luas tulangan tekan 

Adapun perhitungan balok persegi bertulangan rangkap sebagai berikut: 

1. Terlebih dahulu menentukan besar ρmaks dan ρb dari tabel 2.6. 

2. Hitung As1   ρmaks . b . d; Mu1 = Ru maks .b.d
2
 dan Mu2 = Mu - Mu1  
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3. Hitung d' = tebal selimut beton + diameter tul. Geser + ½ diameter tul. 

Tekan. 

 

4. Hitung A's dan As dengan rumus sebagai berikut: 

 

     
   

           
 

  

Maka, luas total tulangan tarik adalah As = As1 + A's. 

5. Periksa tulangan tekan sudah leleh: 

   
        

              
 

   
 

  
 

           (
    

 
) 

6. Periksa apakah tul. Tarik sudah leleh atau tidak: 

          (
   

 
) 

7. Pilih tulangan untuk As dan A's sesuai luasan tulangan yang dihitung. 

8. Periksa lebar dan tinggi minimum balok dengan rumus dibawah: 

bmin = 5db + 100; db = diameter tulangan baja yang digunakan 

hmin = d2 + s/2 + db + 10 + 40 
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Gambar 2.6 Diagram alir Balok persegi 
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Untuk perencanaan lebar efektif dan tebal balok sudah diatur 

dalam SNI-03-2847-2002 tentang tata cara perhitungan struktur beton 

untuk bangunan gedung. SNI-03-2847-2002 menyajikan tinggi minimum 

balok sebagai berikut ini. 

a. Balok di atas dua tumpuan h min = L/16. 

b. Balok dengan satu ujung penerus =  L/18,5. 

c. Balok dengan kedua ujung penerus =  L/21. 

d. Balok kantilever = L/8, dengan L = panjang bentang dsri tumpusn 

ke tumpuan. 

 

c. Balok L / T 

 
                                  Gambar 2.7 Penampang balok T 

 

keterangan: 

hf       = Tebal sayap,  

b     = lebar balok, 

w    = jarak bersih antar balok dan  

be      = lebar sayap 
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Sedangkan untuk ketentuan lebar   balok T dan L, ( SNI-2847-

2013) sebagai berikut ini. 

1. Pada konstruksi balok T,  sayap dan balok harus dibangun 

menyatu atau bila tidak harus dilekatkan bersama secara efektif. 

2. Lebar slab efektif sebagai sayap balok T tidak boleh melebihi 

seperempat panjang bentang balok, dan lebar efektif sayap yang 

menggantung pada masing-masing sisi badan balok tidak boleh 

melebihi: 

1) Delapan kali tebal slab, dan 

2) setengah jarak bersih ke badan di sebelahnya. 

a. Untuk   balok   dengan   slab   pada   suatu   sisi   saja,   lebar   

efektif   yang menggantung tidak boleh melebihi : 

1) 1/12 Panjang bentang balok.   

2) enam kali tebal slab, dan 

3) setengah jarak bersih ke badan disebelahnya. 

Langkah - langkah mendesain balok T sebagai berikut: 

1. Jika d diketahui dan As harus dicari: 

a) Periksa apakah penampang memenuhi syarat untuk dianggap 

sebagai penampang T dengan mengasumsikan a = hf dan hitung kuat 

momen yang disumbangkan oleh seluruh bagian sayap: 

Mn = (0,85.f'c)b.hf (d-hf/2) 

b) Jika Mu > Mn, maka a > hf, sedangkan  Mu  Mn, maka a  hf 

dan penampang dapat didesain seperti balok persegi. 
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c) Jika a  hf, maka hitung ρ dengan menggunakan persamaan 

sebagai berikut: 

   
        

  
*  √

     

           
+ 

d) Periksa juga bahwa ρw ≥ ρmin  

e) Jika a > hf, tentukan Asf: 

Asf = 0,85f'c(b-bw)hf/fy 

Mu2 = Asf  . fy .(d-hf/2) 

Momen yang dipikul bagian badan adalah: 

Mu1 = Mu – Mu2 

f)  itung ρ  menggunakan Mu1, bw dan d dengan persamaan sebagai 

berikut: 

   
        

  
*  √

     

       
+ 

 

g)  entukan As    ρ1.bw.d; maka As = As1 +Asf. 

h) Lalu periksa bahwa As   As maks serta periksa pula ρw = 

 As bw d  ≥ ρmin. 

i) Jika a = hf, maka As = (0,85f'c)b.hf/fy. 

 

2. Jika d dan As adalah dua besaran yang belum diketahui: 

a) Asumsikan a= hf dan hitung luas tulangan yang diperlukan untuk 

memikul gaya tekan di seluruh penampang sayap: 
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b) Hitung d berdasarkan pada Asft dan a = hf dari persamaan sebagai 

berikut: 

Mu = . Asft. fy (d – hf/2) 

c) Jika nilai d diperoleh, maka As = Asft dan h = d + db/2 + 50 mm 

(untuk 1 lapisan tulangan) atau h = d + db + 62,5 mm (untuk 2 

lapisan tulangan). 

d) Jika diambil nilai d1 lebih besar daripada nilai d maka 

perhitungan penampang berlaku sebagai penampang persegi dan 

nilai ρ dapat dihitung dari persamaan    ; As   ρ b d  Asft. 

e) Bila diambil nilai d2 yang lebih kecil daripada nilai d maka 

perhitungan penampang berlaku sebagi penampang balok T, dan As 

> Asft, selanjutnya dapat diteruskan dalam langkah 1c untuk 

menghitung nilai As. 
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BAB III 

METODOLOGI PENELITIAN 

 

3.1 Gambaran Umum 

Metode penelitian ini menggunakan metode studi kasus. Metode studi kasus 

berupa pembuatan ulang dengan menggunaan model yang dibuat sesuai kondisi 

bangunan yang  tercantum  dalam  Rencana  Kerja  dan  Syarat-syarat  dengan  

menggunakan software   SAP 2000 v.12. Evaluasi dimensi tulangan dilakukan   

mengacu   pada   kaidah   SNI   2847:2013. Persyaratan Beton Struktural untuk 

Bangunan Gedung Tata Cara Perencanaan Ketahanan Gempa untuk Struktur 

Banguan Gedung dan Non Gedung serta PPIUG 1983 dan SNI 03-1726-2002 

sebagai acuan dalam memasukan ketentuan berat yang dipikul oleh struktur 

tersebut. 

 

3.2 Teknik Pengelohan data 

1. Menghitung pembebanan bangunan berdasarkan Peraturan Pembebanan 

Indonesia untuk Gedung 1983. 

2. Mendimensi portal yang ditinjau sesuai gambar yang didapat guna untuk 

analisa struktur pada aplikasi SAP 2000. 

3. Mendapatkan gaya-gaya dalam dari hasil aplikasi SAP 2000 tersebut, 

adapun cara-caranya sebagai berikut: 

a. Buka Program SAP 2000 V.12. 

b. Buka New Model. 

c. Pada Bagan New Model tentukan satuan KN, m, C lalu klik 2D Frames. 
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d. Tentukan Number of Stories ( Jumlah Tingkat ) = 3 tingkat 

 

- Tentukan Number  of Bays ( Jumlah Ruang Kolom ) = 3 ruang 

- Tentukan Story Height ( Tinggi Tingkat ) = 4 m 

- Tentukan Bay Width ( Jarak Kolom ) = 3 m 

- Klik Ok 

Gambar 3.1 Menentukan dimensi portal 

e. Hapus semua rangka batang, dengan cara memblock semua rangka 

yang tergambar lalu di delete sehingga yang tampak hanya Grid nya 

saja. 

f. Klik Menu Define > Coordinate System/Grid > Modify/Show System 

- Ubah tinggi lantai ( X Grid Data ) sesuai perencanaan. 

- Kilk OK > OK 
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Gambar 3.2 Bagan Define Grid System Data 

g.  Klik menu Define > Section Properties > Frame Section 

 

Gambar 3.3  Frame Properties 

- klik Add New Property 

- pada Frame Section Property Type, pilih Concrete 

- Klik Rectangular 
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Gambar 3.4 Add Frame Section Property 

- Isi pada Section Name dengan Kolom 30x30 

- Tentukan Depth ( tinggi balok ) = 0.30 

- Tentukan Width ( lebar balok ) = 0.30 

- Kilik OK 

- Lakukan hal yang sama untuk membuat Property Balok Induk dan 

Ring Balok. 

 

 

Gambar 3.5 Rectangular  Section 

h. Klik menu Draw > New Labels 

- Ganti angka Joint dan Frame/Cable menjadi angka 1. 
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Gambar 3.6 New  Labels 

i. Klik menu Draw > Draw Frame/Cable/Tendon 

- Ubah Section menjadi Kolom 

- Gambarkan Kolom sesuai dengan Grid yang telah dibuat 

- Lakukan hal yang sama untuk menggambarkan Ring Balok dan 

Balok induk. 

 

 

Gambar 3.7 Properties of  Object 
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Gambar 3.8 Menggambar  Rangka Portal 

j. Klik Joint pada tiap Pondasi 

 

- Pilih menu Assign > Joint > Restraint, lalu pili Pondasi Jepit 

- Klik OK 

 

  

Gambar 3.9 Joint Restraints / Pondasi 
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Gambar 3.10 Gambar  Pondasi 

k. Pilih Menu Define > Load Patterns 

- Ganti Load Pattern Name menjadi Mati,ubah Self Weight 

Multiplier jadi 0. 

- Klik Add New Load Pattern 

- Lakukan hal yang sama untuk menambah Beban Hidup 

- Untuk Load Pattern DEAD bisa dihapus dengan cara klik Delete 

Load Pattern. 

 

 

Gambar 3.11 Define Load  Patterns 

l. Pilih menu Define > Load Cases > hapus DEAD dan MODAL 

- Klik OK
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Gambar 3.12 Define Load Cases 

 

m. Pilih menu Define > Load Combination > Add New Combo 

- Ubah Load Combination Name menjadi 1,2D +1,6L 

- Pilih Load Case Name > HIDUP, lalu ganti Scale Factor menjadi 

1,6,    Add 

- Pilih Load Case Name > MATI, lalu ganti Scale Factor 

menjadi 1,2,   Add 

- Klik OK > OK 

 

 

Gambar 3.13 Load Combination Data 
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n. Pilih Rangka Batang yang akan diberi beban 

- Klik Assign > Frame Load > Distributed 

- Ganti Load Pattern Name, jadi MATI untuk memasukkan beban 

MATI. 

- Klik Add to Existing Load 

- Masukkan beban merata pada Load, contoh 18,38 KN/m 

- Klik OK 

 

  

Gambar 3.14 Frame Distributed Loads 

 

- Lakukan hal yang sama pada batang-batang yang lain 

- Jika ingin memasukkan beban terpusat maka pilih Assign > 

Frame 

  Load > Point, lakukan hal yang sama seperti di atas 

- Untuk memasukkan beban HIDUP, maka pada Load Pattern 

Name ganti menjadi HIDUP, selanjutnya sama seperti di atas. 
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 Gambar 3.15 Pembebanan Portal 

 

 

    Gambar 3.16 Hasil Perhitungan Pembebanan 

 

o. Pilih Menu Analyze > Run Analysis > Run Now, lalu simpan. 
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Diagram Alir 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Gambar 3.17 Flowchart Perhitungan Dimensi Tulangan Balok 
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